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Introduction

 

One requirement for design engineers using programmable devices is to be able to calculate the power dissipation
for a particular device used on a board. Lattice’s ispLEVER

 

®

 

 design tools include the Power Calculator tool which
allows designers to calculate the power dissipation for a given device. This technical note provides users with
details for using the Power Calculator to calculate the power consumption of the Lattice MachXO™ family of
devices. General guidelines for reducing power consumption are also included.

 

Power Supply Sequencing and Hot Socketing

 

The MachXO devices have been designed to ensure predictable behavior during power-up and power-down.
Power supplies can be sequenced in any order. During power-up and power-down sequences, the I/Os remain in
tristate until the power supply voltage is high enough to ensure reliable operation. In addition, leakage into I/O pins
is controlled to within specified limits listed in the device data sheet. This allows for easy integration with the rest of
the system. These capabilities make the MachXO ideal for many multiple power supply and hot-swap applications.

 

Recommended Power-up Sequence

 

As described in the previous paragraph, the supplies can be sequenced in any order. However, once internal power
is achieved (determined by VCC, VCCAUX) the device releases I/Os from tristate and the management of I/Os
becomes the designer’s responsibility. Therefore, to simplify a system design it is recommended that supplies be
sequenced VCCIO, VCC, VCCAUX. If VCCIO is tied to VCC or VCCAUX, it is recommended that VCCIO and the
associated power supply are powered up before the remaining supply.

Please refer to the Hot Socketing section of the device data sheet for more information.

 

Power Calculator Hardware Assumptions

 

Power consumption of the device can be broken down coarsely into the DC portion and the AC portion. 

The Power Calculator reports the power dissipation in terms of:

1. DC portion of the power consumption
2. AC portion of the power consumption

The DC power (or the static power consumption) is the total power consumption of the used and the unused
resources. These power components are fixed for each resource and depend upon the number of resource units
utilized. The DC component also includes the static power dissipation for the unused resources of the device.

The AC portion of the power consumption is associated with the used resources and is the dynamic part of the
power consumption. Its power dissipation is directly proportional to the frequency at which the resource is running
and the number of resource units used.

 

Power Calculator

 

Power Calculator Equations

 

The power equations used in the Power Calculator are shown below.
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Total DC Power (Resource)
= Total DC Power of Used Portion + Total DC Power of Unused Portion
= [DC Leakage per Resource when Used * N

 

RESOURCE

 

] 
+ [DC Leakage per Resource when Unused * (N

 

TOTAL RESOURCE

 

 - N

 

RESOURCE

 

)]

Where,

N

 

TOTAL RESOURCE

 

 is the total number of resources in a device
N

 

RESOURCE

 

 is the number of resources used in the design

The total DC power consumption for all the resources as per the design data is the Quiescent Power in the Power
Calculator.

The AC Power, on the other hand, is governed by the following equation.

Total AC Power (Resource) 
= K

 

RESOURCE

 

 * f

 

MAX

 

 * AF

 

RESOURCE

 

 * N

 

RESOURCE

 

Where,

N

 

TOTAL RESOURCE

 

 is the total number of resources in a device,
N

 

RESOURCE

 

 is the number of resources used in the design,
K

 

RESOURCE

 

 is the power constant for the resource. The units of this factor are mW/MHz.
f

 

MAX

 

is the max. frequency at which the resource is running. Frequency is measured in MHz.
AF

 

RESOURCE

 

is the activity factor for the resource group. Activity factor is in terms of the percentage (%)
of switching frequency.

Based on the above equations, if we wish to calculate the power consumption of the slice portion, it will be as
shown below.

Total DC Power (Slice)
= Total DC Power of Used Portion + Total DC Power of Unused Portion
= [DC Leakage per Slice when Used * N

 

SLICE

 

]
+ [DC Leakage per Slice when Unused * (N

 

TOTAL SLICE

 

 - N

 

SLICE

 

)]

Total AC Power (Slice) 
= K

 

SLICE

 

 * f

 

MAX

 

 * AF

 

SLICE

 

 * N

 

SLICE

 

Power Calculations

 

The Power Calculator is a powerful tool which allows users to estimate power consumption at three different levels:

1. Estimate of the utilized resources before completing place and route
2. Post place and route design
3. Post place and route, post trace, and post simulation

For first level estimation, the user provides estimates of device usage in the Power Calculator Wizard and the tool
provides a rough estimate of the power consumption.

In the second level, a more accurate approach, the user imports the actual device utilization by importing the post
place and route netlist (NCD) file. 

The third and final stage brings even more accuracy to the calculation, by importing the Trace (TWR) file to popu-
late the maximum frequencies (f

 

MAX

 

) into the tool. Users also have the option of importing the information from the
post simulation (VCD) file and calculating the activity factor and toggle rates of various components. 

These power calculations are discussed in detail in the following sections of this document.
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Starting the Power Calculator

 

The user may launch the Power Calculator using one of two methods. The first method is by clicking the 

 

Power
Calculator button

 

 in the toolbar as shown in Figure 11-1.

 

Figure 11-1. Starting Power Calculator From the Toolbar

 

Alternatively, users can launch the Power Calculator by going to the 

 

Tools

 

 menu and selecting 

 

Power Calculator

 

as shown in Figure 11-2.
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Figure 11-2. Starting Power Calculator from Tools Menu

 

The Power Calculator does not support some of Lattice’s older devices. The toolbar button and menu item is only
present when supported devices are selected.

 

Creating a Power Calculator Project

 

After starting the Power Calculator, the user will see the Power Calculator window. Click on 

 

File -> Menu

 

 and select

 

New

 

 to get to the Start Project window, as shown in Figure 11-3.
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Figure 11-3. Power Calculator Start Project Window (Create New Project)

 

The Start Project window is used to create a new Power Calculator project (*.pep project). Three pieces of data
must be input into the Start Project window:

1. The Power Calculator project name by default is the same as the Project Navigator project name. This can 
be changed, if desired.

2. The Project directory is where the Power Calculator project (*.pep) file will be stored. By default it is stored 
in the Main Project folder.

3. The NCD file is automatically selected if available or users can browse to the NCD file in a different loca-
tion.

 

Power Calculator Main Window

 

The main Power Calculator window is shown in Figure 11-4.
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Figure 11-4. Power Calculator Main Window (Type View)

 

The top pane of the window shows information about the device family, device and the part number as it appears in
the Project Navigator. The V

 

CC

 

 used for the power calculation is also listed. Users have a choice of selecting the
core voltage, V

 

CC

 

 with +5% of the nominal value (or values). The option of selecting V

 

CCJ

 

 is also available. Users
provide the ambient temperature and the junction temperature is calculated based on that.

Users can also enter values for airflow in Linear Feet per Minute (LFM) along with heat sink to get the junction tem-
perature. 

A table in the top part of the Power Calculator summarizes the currents and power consumption associated with
each type of power supply for the device. This also takes into consideration the I/O power supplies. 

In the middle pane of the window, there are three tabs:

1.

 

Power View:

 

 The first tab is the Power View. Under this tab, the Power Calculator tool has an interactive 
spreadsheet type interface with all values in terms of power consumption mW.

The first column breaks down the design in terms of clock domains. The second and third columns, which 
are shaded blue in the tool, provide the DC (or static) and AC (or dynamic) power consumption, respec-
tively. 

In case of the I/Os, there are four columns that are shaded blue. These provide the DC and AC power for 
I/Os for the core voltage, V

 

CC

 

 and the I/O voltage supply, V

 

CCIO.

 

The first three rows show the Quiescent Power for V

 

CC,

 

 V

 

CCAUX

 

 and V

 

CCJ.

 

 These are DC power numbers 
for a blank device or a device with no resource utilization.
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Some of the cells are shaded yellow in the tool. These cells are editable cells and users can type in values 
such as frequency, activity factors and resource utilization. The second tab, the Report tab, is the summary 
of the Power View. This report is in text format and provides the details of the power consumption. 

2.

 

I

 

CC

 

 View:

 

 The second tab is the I

 

CC

 

 view. This tab is exactly same as the Power View tab, except that all 
values are in terms of current or mA.

3.

 

Report:

 

 The third and final tab is the Report View. This is an HTML type of Power Calculator report. It sum-
marizes the contents of the Power and I

 

CC

 

 views.

The final pane or the lower pane of the window is the log pane where users can see the log of the various opera-
tions in the Power Calculator.

 

Figure 11-5. Power Calculator Main Window (Power Report View)

 

Power Calculator Wizard

 

The Power Calculator Wizard estimates the power consumption of a given design. This estimation is done before a
design is created. The user must understand the logic requirements of the design. The wizard allows the user to
provide these parameters and then estimates the power consumption of the device.

To start the Power Calculator in the Wizard mode, go to the 

 

File

 

 menu and select 

 

Wizard

 

. Alternatively, click on the

 

Wizard

 

 button to get the 

 

Power Calculator - Wizard window

 

 as shown in Figure 11-6. Select the option 

 

Create a
New Project

 

 and check the 

 

Wizard

 

 check box in the 

 

Power Calculator Start Project

 

 window. Users are required
to provide the project name and the project folder. Click 

 

Continue

 

. Since this is power estimation before the actual
design, no NCD file is required. 
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Figure 11-6. Power Calculator Start Project Window (Using the New Project Window Wizard)

 

The next screen allows users to select the device family, device and appropriate part number for which users plan
to estimate power. After making the proper selections, click “Continue” (see Figure 11-7).

 

Figure 11-7. Power Calculator Wizard Mode Window - Device Selection
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In the following screens, as shown in Figures 8-12, users can select further resources, like I/O types, clock name,
frequency at which the clock is running, and other parameters, by selecting the appropriate resource using the pull-
down menu:

1. Routing Resources
2. Logic
3. EBR 
4. I/O
5. PLL
6. Clock Tree

The numbers in these windows refer to the number of clocks and the index corresponds to each clock. By default,
the clock names are clk_1, clk_2, and so on. Users can change the name of each clock by typing in the 

 

Clock
Name

 

 text box. For each clock domain and resource, users can specify parameters such as frequency, activity fac-
tor, etc. In the final window, users must click the 

 

Create

 

 button for each clock-driven resource to include the param-
eters they have specified for it.

 

Figure 11-8. Power Calculator Wizard Mode Window - Resource Specification 

 

These parameters are then used in the 

 

Power Type View

 

 window, which can be seen upon clicking on 

 

Finish

 

(Figure 11-9).
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Figure 11-9. Power Calculator Wizard Mode - Main Window

 

Power Calculator - Creating a New Project Without the NCD File

 

When starting a new project without the NCD file, begin either by using the 

 

Wizard

 

 (as discussed above) or by
selecting the 

 

Create a New Project

 

 option in the 

 

Power Calculator -> Start Project

 

. Users are required to provide
a project name and project directory. After clicking 

 

Continue

 

 the Power Calculator main window will be displayed.

However, in this case there are no resources added. The power estimation row for the routing resources is always
available in the Power Calculator. Users are required to add more information like the slice, EBR, I/O, PLL and
clock tree utilization to calculate the power consumption.

For example, if the user wants to add the logic resources as shown in Figure 11-10, right-click on 

 

Logic

 

 and select

 

Add Row

 

 in the pop-up menu. 
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Figure 11-10. Power Calculator Main Window - Adding Resources

 

This adds a new row for the logic resource utilization with clock domain as clk_1.

Similarly, users can add other resources like EBR, I/Os, PLLs, routing, etc. Each of these resources is for the AC
power estimation and categorized by clock domains.

 

Power Calculator - Creating a New Project with the NCD File

 

If the post place and routed NCD file is available, the Power Calculator can use this file to import accurate informa-
tion about the design data and resource utilization and calculate the power. When the Power Calculator is started,
the NCD file is automatically placed in the NCD File option, if it is available in the project directory. Otherwise,
browse to the NCD file in the Power Calculator.
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Figure 11-11. Power Calculator Start Project Window with Post PAR NCD File

 

The information from the NCD file is automatically inserted into the correct rows. Power Calculator uses the clock
names from the design as shown in Figure 11-12.
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Figure 11-12. Power Calculator Main Window - Resource Utilization Picked up from the NCD File

 

Power Calculator - Open Existing Project

 

The Power Calculator - Start Project window also allows users to open an existing project. Select the option 

 

Open
Existing Project

 

, browse to the *.pep project file and click 

 

Continue

 

. This opens the existing project in similar win-
dows, as discussed above. This is shown in Figure 11-13.
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Figure 11-13. Opening an Existing Project in the Power Calculator

 

Power Calculator - Importing Simulation File (VCD) to the Project

 

Users can import the post simulation VCD file into the power calculator project to estimate their design’s activity
factors. Select 

 

Open Simulation File

 

 option under the 

 

File

 

 menu, browse to the VCD file location and select 

 

Open

 

.
All AF and toggle rate fields are populated with the information from this file. This is shown in Figure 11-14.
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Figure 11-14. Importing Simulation File in the Existing Project in the Power Calculator

Power Calculator - Importing Trace Report File (TWR) to the Project
Users can import the post Trace TWR file into the Power Calculator project to estimate their design’s activity fac-
tors. Select Open Trace Report File option under the File menu, browse to the TWR file location and select Open.
All Freq. (MHZ) fields are populated with the information from this file. This is shown in Figure 11-15.
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Figure 11-15. Importing Trace Report File in the Existing Project in the Power Calculator

Activity Factor and Toggle Rate
Activity Factor% (or AF%) is defined as the percentage of frequency (or time) that a signal is active or toggling of
the output. Most of the resources associated with a clock domain are running or toggling at some percentage of the
frequency at which the clock is running. Users are required to provide this value as a percentage under the AF%
column in the Power Calculator tool.

Another term used for I/Os is the I/O Toggle Rate or the I/O Toggle Frequency. The AF% is applicable to the PFU,
routing and memory read write ports, etc. The activity of I/Os is determined by the signals provided by the user (in
the case of inputs) or as an output of the design (in the case of outputs). So, the rates at which I/Os toggle defines
their activity. The Toggle Rate (or TR) in MHz of the output is defined as: 

Toggle Rate (MHz) = 1/2 * fMAX * AF%

Users are required to provide the TR (MHz) value for the I/O instead of providing the frequency and AF% in case of
other resources. The AF can be calculated for each routing resource, output or PFU, however it involves long calcu-
lations. The general recommendation of a design occupying roughly 30% to 70% of the device is that the AF%
used can be between 15% to 25%. This is an average value that can be seen most of the design. The accurate
value of an AF depends upon clock frequency, stimulus to the design and the final output.

Ambient and Junction Temperature and Airflow
A common method of characterizing a packaged device’s thermal performance is with Thermal Resistance, θ. For
a semiconductor device, thermal resistance indicates the steady state temperature rise of the die junction above a
given reference for each watt of power (heat) dissipated at the die surface. Its units are °C/W.
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The most common examples are θJA, Thermal Resistance Junction-to-Ambient (in °C/W) and θJC, Thermal Resis-
tance Junction-to-Case (also in °C/W). Another factor is θJB, Thermal Resistance Junction-to-Board (in °C/W). 

Knowing the reference (i.e. ambient, case or board) temperature, the power and the relevant θ value, the junction
temp can be calculated as per the following equations.

TJ = TA + θJA * P . . . . . . . . . . (1)

TJ = TC + θJC * P . . . . . . . . . . (2)

TJ = TB + θJB * P . . . . . . . . . . (3)

Where TJ, TA, TC and TB are the junction, ambient, case (or package) and board temperatures (in °C) respectively.
P is the total power dissipation of the device.

θJA is commonly used with natural and forced convection air-cooled systems. θJC is useful when the package has a
high conductivity case mounted directly to a PCB or heatsink. And θJB applies when the board temp adjacent to the
package is known.

Power Calculator utilizes the ambient temperature (°C) to calculate the junction temperature (°C) based on the θJA
for the targeted device, per equation 1 above. Users can also provide the airflow values (in LFM) to get a more
accurate value of the junction temperature. 

Managing Power Consumption
One of the most critical design factors today is reducing system power consumption, especially for modern hand-
held devices and electronics. There are several design techniques that designers can use to significantly reduce
overall system power consumption. Some of these include:

1. Reducing operating voltage.
2. Operating within the specified package temperature limitations.
3. Using optimum clock frequency reduces power consumption, as the dynamic power is directly proportional 

to the frequency of operation. Designers must determine if a portion of their design can be clocked at a 
lower rate which will reduce power.

4. Reducing the span of the design across the device. A more closely placed design utilizes fewer routing 
resources for less power consumption.

5. Reducing the voltage swing of the I/Os where possible.
6. Using optimum encoding where possible. For example, a 16-bit binary counter has, on average, only 12% 

Activity Factor and a 7-bit binary counter has an average of 28% Activity Factor. On the other hand, a 7-bit 
Linear Feedback Shift Register could toggle as much as 50% Activity Factor, which causes higher power 
consumption. A gray code counter, where only one bit changes at each clock edge, will use the least 
amount of power, as the Activity Factor would be less than 10%.

7. Minimize the operating temperature, by the following methods:
a. Use packages that can better dissipate heat. For example, packages with lower thermal impedance.
b. Place heat sinks and thermal planes around the device on the PCB.
c. Better airflow techniques using mechanical airflow guides and fans (both system fans and device

mounted fans).

Power Calculator Assumptions
The following are the assumptions made in the Power Calculator:

1. The Power Calculator tool is based on equations with constants based on room temperature of 25°C.
2. The user can define the Ambient Temperature (TA) for device Junction Temperature (TJ) calculation based 

on the power estimation. TJ is calculated from user-entered TA and power calculation of typical room tem-
perature.



11-18

Power Estimation and Management
Lattice Semiconductor for MachXO Devices

3. The I/O power consumption is based on output loading of 5pF. Users have ability to change this capacitive 
loading.

4. The current version of the Power Calculator allows users to get an estimate of the power dissipation and 
the current for each type of power supplies, that are VCC, VCCIO, VCCJ and VCCAUX.

5. The nominal VCC is used by default to calculate power consumption. Users can choose a lower or higher 
VCC from a list of available values. 

6. The current versions also allow users to enter an airflow in Linear Feet per Minute (LFM) along with the 
heat sink option to calculate the junction temperature.

7. The default value of the I/O types for the devices is LVCMOS12, 6mA.
8. The Activity Factor is defined as the toggle rate of the registered output. For example, assuming that the 

input of a flip-flop is changing at every clock cycle, 100% AF of a flip-flop running at 100MHz is 50MHz.

Technical Support Assistance
Hotline: 1-800-LATTICE (North America)

+1-503-268-8001 (Outside North America)

e-mail: techsupport@latticesemi.com

Internet: www.latticesemi.com
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Date Version Change Summary

July 2005 01.0 Initial release.

September 2007 01.1 Document title changed to: “Power Estimation and Management for 
MachXO Devices.”
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